APPENDIX

Materials and Software
A. Sample Activity: Weak Attractions Between Molecules
B. The MoLo Database of Activities
C. Pedagogical Aspects of a Molecular Workbench Activity
D. The Online Tutorial
E. Adapting an Activity: Making it Your Own

Assessment Support
F. On-line Feedback Form
G. MoLo Telephone Questionnaire
H. Student Report: How Mutations Work
APPENDIX A:  
SAMPLE ACTIVITY - WEAK ATTRACTIONS BETWEEN MOLECULES

1. The unit begins with students exploring a mixture of polar (red and purple) and non-polar (green) molecules. They select different molecules as "probes," bringing them close to other molecules, thus making and breaking van der Waals (VDW) attractions depending on proximity. They discover that both polar and non-polar molecules are attracted to each other.

2. Students work with two liquid compounds, one polar and the other non-polar. They use heat to test the strength of the intermolecular attractions, and discover that in polar compounds the attractive forces are stronger, requiring higher temperatures to vaporize the polar substance.

3. Students can choose to view hints as needed to help guide their inquiry.

4. To bring relevance, students explore attractions between two molecules, an antibody (green) and its specific antigen (white). They discuss with each other how the antibody can attract and stick to its specific antigen. Using an interactive 3D molecular viewer, students uncover the inner structure of the antigen-antibody complex.
5. In this dynamic model two identical antibodies interact with two different antigens, one that fits an active site (green) and one that does not (brown). Students discover that the attractive forces between the molecules increase with an increase in the area of complementarity. Using heat, they can assess the strength of the attraction.

6. Students undertake a set of challenges to test their comprehension. One of the challenges calls for students to create a set of non-polar molecules that can still stick together under moderate temperatures. Students design molecules of different sizes, experiment with changes in temperature and explain their results. Students should determine that such compounds will be composed of molecules with large interacting surfaces, allowing VDW attractive forces to be significant enough to resist disruption by heat.

7. Student answers to embedded multiple choice questions and essay questions, as well as their annotated snapshots, are automatically collected in a Final Report and recorded in a final report that can be saved on the server as an HTML file or printed. Students use callouts in the snapshots to point to specific areas of the model to describe their observations. Collections of annotated snapshots representing different stages of the modeling activity can be saved. Teachers can use Final Reports to assess student understanding.
APPENDIX B: THE MoLo DATABASE of ACTIVITIES

This database, found at http://molo.concord.org, was built for the Molecular Logic Project, but it includes some activities created in earlier projects such as its precursor, the Molecular Workbench, or by other projects, e.g. the software Biologica. Furthermore, some of the activities were created by the author of the Molecular Workbench and other staff members and associated users. The activities, therefore, do not have a unified format.

To locate activities in the database, click on the “Use Our Database” link.

1. Locating An Activity
   Clicking on the top level of icons will bring up different sets of activities. You can locate an activity in a number of ways.

   You can click on the icon that will take you ONLY to the core Molecular Logic “Stepping Stone” science activities.

   By clicking on this icon you can browse through the activities one at a time.

   This set of activities are organized by discipline: Biology, Molecular Biology, Chemistry, Physics, or Systems.

   Many of the activities have been linked to the most common biology textbooks.

   Activities have been sorted into modules of related material.

   Activities are linked to NSES Standards and AAAS Benchmarks, when possible.
At the top of the database introductory page, http://molo.concord.org/database/users can type in the activity number they desire, and indicate which view, Student or Teacher, they wish to see. The Student View eliminates all but the activity itself from view. Users can also type in keywords.

2. The Activity List Pages
Clicking on the above buttons will bring up activity lists, each item in the list is a link to a database page unique to that activity.

Activity List
- A Comparison of Liquid and Gas States
- Activation Energy [advanced]
- Active Filters (demo)
- Air Filtration
- Amino Acids and Water: 20 Alanine Model
- Aquatic Solutions and Our Cells (Five-day unit)
- Atomic Structure
- Attractive Forces and Phase Change: (Atoms in Motion)
- BioLogica (Entire module)
- Brownian Motion and Refrigeration: Atoms and molecules are always moving

Note the option, on the Everything page, to see the whole list. One list shows which activities are editable.

3. The Database Pages

Activity Number and Ability to be Edited
The top left of the database page contains the activity number. This number, when typed into the “Jump to Activity” box, will bring the user to the database page for that activity. Numbers are constant, but not continuous, as models are developed and some are then deleted.

Some activities are authored using only the MW software tool and can be edited by users, such as staff, teachers, researchers, or NSF officers. (The majority of the activities found in the database are of this kind). The “workbench with molecules icon” below the activity number indicates whether or not the activity is editable. You can copy these to your computer, open the Editor, and change the pages. (See Appendix E: Adapting an Activity to learn about editing activities.

Other activities involve an alternate environment that requires advanced programming but utilizes the same MW molecular dynamic engines. A small handful of activities are also created using Macromedia Flash. These are not editable.
Scaffolding

The level of pedagogical support within an activity is coded by one of three icons, square, circle or triangle, each indicating the amount of interaction and pedagogical scaffolding present. An example of each is displayed below:

Activity Image, Launch and Requirements

Under the Activity image there is a “Launch Activity”, that will run an activity automatically, if you have installed the software. There is a link to test your computer system to make sure you have the right version of Java, and a link to more Help.

4. Available Teacher Support
Support is linked through a set of icons (listed below). We are always updating this information (Icons and related information only appear where there is information in the database.)

Overview, with Goals and Objectives
This includes the primary goal and a set of objectives.

Key Concepts
This includes a key sentence or two and a set of keywords that may be located in the database search.

Benchmarks and Standards
At the moment these Benchmarks and Standards are secondary education (NSES and AAAS).

Classroom Practice
This includes suggestions for classroom configuration, relationship to labs and more.
Extensions
This suggests labs and related readings that continue the main theme of the activity.

Textbook Links
This includes links to the most popular biology textbooks in use.

Additional Background
This includes more background information to support the activity theme.

Requirements
This includes any technology requirements, e.g. Java versions.

Activity Credits
This ascribes model development to a particular NSF-funded project or author from outside CC.

Assessments
This provides some extra assessment questions, and links to sample reports.

Technical Notes
This provides technical information on the model itself not provided in another part of the page.

Micro Macro
This is present when the activity connects the molecular world with macro themes.

Concept Map Present
APPENDIX C. PEDAGOGICAL ASPECTS OF A MOLECULAR WORKBENCH ACTIVITY

THE IMPORTANCE OF CHARGE IN POLAR ATTRACTIONS

Above are two polar molecules, one with fewer charged regions than the other.

- = fewer charged regions
- = more charged regions

Use the heat and cool buttons to determine the effect of charged areas on the ability of polar molecules to stick to each other.

Which polar molecules have a stronger attraction for each other?

- A. The ones with more charged areas (or polar regions).
- B. The ones with fewer charged areas (or polar regions).
- C. They both attract equally.

Explain why some polar molecules can form a stronger attraction than others

This includes two pages from the modeling activity Weak Attractions Between Molecules. Students compare attractions between molecules by varying the polarity of the diatomic molecules and varying temperature to test the strength of intermolecular attractions. Dotted lines representing weak attractive forces are dynamically generated by the model. The pages include the following components: (A) Instructions to guide student interactions with models; (B) A "hint" button; (C) Multiple choice questions to assess students work; (D) A scrollable window for student entry of answers to open-ended questions; (E) A snapshot tool that supports student annotation of features; (F) A snapshot gallery to access and organize snapshots. A report is automatically generated that includes all student responses to questions and snapshots. This report can be edited, shared, and submitted to the teacher. (See Appendix H: Student Report.)
Appendix D: The Online Tutorial
Sample pages from the online tutorial delivered in Blackboard and tested with MoLo teachers. Links take users to readings, activities, or discussion areas.
Opening Page

Setting Up to Run Models

Download the software
Install Software
Before you can get started using the models, you will need to download several pieces of software to your computer. The directions for downloading all of the components needed to run the molecular models can be found at http://mojol.concord.org/software.

The software webpage includes a test that allows you to see whether you already have the components you need and/or to check your installation after you download the required components. Follow the instructions for downloading the software as they are presented. The order in which some of the software is installed is important.

Notice that, if you have any problems, there are several suggested steps you can take to troubleshoot your installation. There are potential problems related to firewalls, filtering software, and so forth that could be the culprit. If you are having difficulty loading the software on your computer(s), you might want to call your technical support person to help with the installation. If you or your tech support person needs more detailed installation instructions, follow the link in the green shaded box.

Software Usage
The software used in developing the Molecular Literacy models is OPEN SOURCE, and the activities, while COPYRIGHTED, are available free of charge for all educational purposes. The complete license and copyright information can be found at http://www.concord.org/license.html.

Materials you download can stay on your machine. Some will be automatically upgraded as new versions become available.

Concord Consortium is committed to maintaining the software as long as is possible.

Feedback forms
Please register for filling in your on-line feedback forms. This is one of the ways we learn whether or not our model-based activities have succeeded in your classroom, and what problems you encountered. If you have not registered, please go now to http://mojol.concord.org/feedback and register. Thank you!

Collecting Student Work
Printing Saved Reports.doc (51.000 bytes)
This document describes how you should direct your students to save their work when using the models.
Using a Model

Model: Diffusion, Osmosis, and Dialysis
This is an expanded version of Diffusion. You will get a sense of the potential.
1. To open this activity, click on http://www.concord.org/~barbara/workbench_web/models/nipsOnAndOffpage1_teachers.html

2. Go through the model as a student, following all of the instructions as given. In most cases you must answer the questions before you are allowed to move forward. Note: Your answers are saved whether you move forward or backward in the lesson until you close the activity. To keep from losing your data when you get to the end or if you need to quit before finishing the activity, you must save and/or print your data. Read the document, Printing Reports, In the Documents section.

3. You will notice as you proceed through the model that there is a box for you to record any questions, comments, or feelings you have related to the model itself, the potential use of the model with your students, or any other thoughts you might have about your experience with the model.

The MW Student Report
Here is an example of a student report including with answers to embedded assessment.

Reflecting on Your Experience with the Models
It's time to go back to the Discussion Board and share your thoughts on the models you just viewed. You can refer back to your notes that you took on this Diffusion model. Below are some additional ideas to shape your discussion:

* Describe your experience as you viewed the models.
* How did you feel?
* How have you taught this topic in the past?
* What did you like and dislike about the model?
* What insights did you have about how you might use models with your students?
* Did you want to change anything about the model?

Read any comments from other participants and respond to their postings. How were your experiences the same or different?
APPENDIX E: ADAPTING AN ACTIVITY - MAKING IT YOUR OWN

Many Molecular Workbench activities can be easily modified by teachers and curriculum writers to fit the needs of their classes. The following steps are an introduction to the basic steps of modifying activities.

1. Find an activity to modify and open it
Either A. Go to the Molecular Workbench Home Page (http://mw.concord.org/modeler/->Library of Models/Activity Center and select one that interests you,

or
B. go to the Molit database http://molit.concord.org/database/browse/everything-list/ and pick an activity marked “editable.”

Browsing Everything
The following are all of the activities, from all categories and me
The models are not sequentially numbered; gaps in numbering
153 activities total. Displaying activities 1 through 10.

Activity List
- A Comparison of Liquid and Gas States
- Activation Energy [advanced]
- Active Filters (demo)
- Air Filtration
- Amino Acids and Water: 20 Alanine Model
- Aquatic Solutions and Our Cells (Five-day unit)
- Atomic Mass and Melting Point
- Atomic Structure
- Attractive Forces and Phase Change: (Atoms in Me
- Biologica (Entire module)

Editable activities will be marked at the top of the activity with an icon:

We suggest for the purpose of this lesson you use something as simple as A Comparison of Liquid and Gas States
http://molo.concord.org/database/activities/201.html
2. Open/launch the activity

![Activity Image]

3. Save your own copy of the activity into a folder

Make a new folder for the activity in an easy-to-find place, and save the activity within it. Click the Save button in the menu bar. MW activities are made up of many files. The text and layout of each page is stored in a .cml file, and each model is stored in a .mml file. For more details: Consult the User’s Guide within the Molecular Workbench: Saving a Page.

![Save Dialogue Box]

4. Switch to Editor mode

Once you have saved the activity, an Editor button will appear at the top left.

![Editor Button]

Click on the Editor button, on the left side of the tool bar. It will open. This button lets you toggle between editing and viewing activities. In editor mode, almost all activity components still work,
but you can edit any item on the page.

5. Edit the text
MW’s editor is a bit like Microsoft Word. For example, you can select some text and delete it, then type in some new text. Easy! You can even undo if you make a mistake (Edit->Undo). Also, try out the text formatting options in the tool bar.
More details: Consult the User’s Guide within the Molecular Workbench: Editing Text

6. What if there is a textbox on the page?
Textboxes sometimes have lines around them but often the lines are invisible. The borders will show in Editor mode. If you want to remove the textbox, just place your cursor to the right of the textbox and press delete. Or double-click on the textbox and click the “Remove This Text Box.”
You might want to insert another textbox and customize it.

7. Customizing a textbox is tricky
Let’s say you want to keep the textbox. You need to Right click (Windows) Apple-click (Mac) on the textbox and the choice of customizing will come up. Selecting that will allow you to enter your own text, as plain text or HTML (required if you want to format text WITHIN the textbox.)

8. What if there is a textbox with HTML code on the page?
You can erase the text in a textbox, including all the HTML code. You can type your own HTML code in the textbox if you want, or you can simply change the text and leave the HTML code (when, for example, you like the font, images etc.) Just avoid changing a <tag>!

9. Add a different picture
It is easy to delete pictures and insert your own. Go to the insert menu.
Insert->Picture->From File
Positioning pictures is NOT easy.
The BEST way to do it right now is insert a text box, make sure your picture is in your folder, and write `<img src="FILENAME.gif">
You will always need the HTML header and footer:
<html>
<head>
</head>
<body>
<img src="PUT_YOUR_FILENAME_HERE.gif">
</body>
</html>`
10. Add a free response question
Suppose you want to ask students an additional question, after the one at the bottom of the page. Click to place the cursor where you want the question to appear, then go to the insert menu (in the menu bar):

Insert->User Input Text Area

In the dialog box that pops up, you can type in your question (and format it using HTML, if you know how), and specify the size of the answer box.

Once the question is there, you can modify it by right-clicking (windows) or Apple-clicking (on mac) on it and selecting “customize this text area.” You can modify other components in the same way.

More details: Consult the User’s Guide within the Molecular Workbench: Adding a Text Area

11. Add a multiple choice question
Put the cursor where you’d like a multiple choice question, and go to:

Insert->Multiple Choice

More details: Consult the User’s Guide within the Molecular Workbench: Adding a Multiple choice

12. Add Links
In MW you can hyperlink to another .cml page. You can make it open in a new window, or the current window (in which case you can come back by using the Back button on the toolbar). You can also link to a web page (which will launch a web browser).

To create a link, simply (1) highlight some text, (2) select the Hyperlink tool in the toolbar, and set the filename or URL to link.

Note that links do not work while you are in editor mode.
For more details: Consult the User’s Guide within the Molecular Workbench: Hyperlinks

The Snapshot button
You can let students take a snapshot of a model (a picture of it at a particular time) by including a snapshot button. Go to:

Insert->Standard Controller for Model->Button

Next to select an action, choose “Take a snapshot” (way at the bottom). You can customize the look and feel of the button.
Snapshots.

**Using reports**

*MW* activity reports gather together all of the answers a student has typed in, as well as any snapshots they have taken. The report is a single .cml file that the student can edit, print, or submit to our database. To use a report in your activity, simply add a "create an activity report" button, by going to:

*Insert*->*Activity Controller*->*Activity Button*

Where it says "Select an action," choose "create an activity report about this page in a new window." This will create a button that students can press at the end of the activity to generate their report. You can also create reports for multi-page activities, which gather the students’ responses across several .cml pages.

For more details: Consult the User’s Guide within the *Molecular Workbench*: Creating a Report.

**15. Upload your page to a database**

You can upload any .cml page you create to our database of user uploads. It's a convenient way to share your model or activity- any molecular workbench user can then access it! To upload, simply go to (while not in editor mode):

*Collaboration*->*Upload current page*

To view uploads, you just go to:

*Collaboration*->*View Uploads*

You can also get to them from
*MW* Home Page->User uploads

**16. More Help**

Check out the amazingly detailed, always up-to-date MW User’s Guide by going to:

*Help*->*Online User’s Guide*

**17. Multi-page Activity Authoring Tips**

Advanced users may want to create elaborate many-page activities like the ones we have created for our projects Molecular Logic and Molecular Literacy. Here are a few tips on how to do this that aren’t currently collected in one place in the user’s guide:

- Store all files used for an activity in one folder. This allows you to automatically upload the whole thing by using *Collaboration*->*Upload Current Activity Folder.*
- Use relative path references, when creating links between .cml pages or using tags.
- Use a reasonable file-naming scheme, such as appending sequential numbers to the name of the file for each activity page. This makes it much easier to link pages together and keep track of them.
- Use the multi-page report button, to gather together questions and snapshots across all pages of the activity.
- Use page titles (set them by going to *Edit*->*Title*)
- On each page, include a link to a table of contents page or some reference to location in the activity, such as "page 3 of 5."
APPENDIX F: Online Feedback Form

The purpose of this survey is to gather teacher feedback on each activity you test. Teacher responses are then assessed and used to guide revisions of the activities.

1. Which activity did you use? Please select from the list. If you used an activity not on the list, please specify its number and title.

   226 Tree of Life’s Macromolecules
   227 Weak Attractions Between Molecules
   225 Protein Folding
   245 DNA to Protein Synthesis

2. I liked this activity enough to use it again next year.

   Disagree  1  2  3  4  5  Agree

   Comments:

3. In general, my students understood what was expected of them when working through the activity.

   Disagree  1  2  3  4  5  Agree

   Comments:

4. The concepts covered in this activity are directly related to the concepts I cover in my classes.

   Disagree  1  2  3  4  5  Agree

   Comments:

5. The level of difficulty of this activity was appropriate for the classes in which I used it.

   Disagree  1  2  3  4  5  Agree

   Comments:

6. The language used in this activity was appropriate for the level of my students.

   Disagree  1  2  3  4  5  Agree

   Comments:

7. Did you have any technical difficulties with this activity?

8. Please describe how you used the activity in your classroom (for example, as a demonstration, classroom activity, or homework). Also, if there was a related laboratory exercise, did you do this before or after the activity?

9. How did you review the activity with your class after students had completed it?

10. Were students confused by a particular word, sentence, question or concept in the activity? How could it be made clearer?

11. Were students frustrated or stumped by any interactive portion of the activity? How could it be improved?
12. Please select **one page** of the activity to give a more detailed review (please choose the page you think needs the most work!). We recommend you load the activity in molecular workbench, find the page you’d like to comment on, and then return to this window.

A. What is the page number and page title?

B. How could the text and any diagrams on this page be improved?

C. How could any models on this page (2D or 3D) be improved?

D. How could the questions on this page be improved?

E. Please describe anything else you liked or disliked about this page, and your suggestions for improving it.
APPENDIX G: MoLo TELEPHONE QUESTIONNAIRE
The goal of the interview is to talk about the implementation of the model-based activities; to identify anecdotes of typical teacher experience; to learn about how teachers implemented the models; To learn about how they connected it to the classroom materials they used; To learn about successes and failures. Below is the telephone protocol used to guide the interview.

<table>
<thead>
<tr>
<th>Teacher Name</th>
<th>School Name</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class Title(s)</td>
<td>Grade</td>
<td># of Students</td>
</tr>
<tr>
<td>Interviewers Name</td>
<td>Field test or Implementation teacher</td>
<td>Sent:</td>
</tr>
<tr>
<td>Sent: Pre-test</td>
<td>Sent: Survey</td>
<td>Sent: Permissions</td>
</tr>
</tbody>
</table>

If you haven’t participated, why not? Was it a problem with: installation or other technical difficulties, matching the content with your curriculum, or something else?

How do you think things are going? (What seems to work well, what doesn’t?)

What were your first impressions?

How did your students respond to the activities? (Did they have fun? Did they look bored? Did it aid their understanding? Do they use concepts in other contexts?)

Which model based activities have you used with your class?

Where in the curriculum did you decide to use the models?
Was it difficult or easy to integrate them?

How did you integrate the activities? (Were they review/assessments/context setters? Were they demonstrations, homework, classroom-based?)

In what ways do you connect the models to the other materials and topic they are working on in class? (Do you use the imagery in later lessons?)

What are your suggestions for improving the design of the models, activities and database?

Do you have any ideas for additional model-based activities that would be useful in for teaching?

Do you use any other computer-based activities in your classes? How does this compare?

Do you have any suggestions for improving the database? (Was the database easy to navigate? What was most useful information in the database?)

Do you think you might use any other activities for the database? If so, which one?
Do you think you will use this software in your class next year?

Would you recommend it to other teachers?

APPENDIX H. Student Report (following page)

The following is an actual student report from a Molo activity. Please note the use of snapshots and descriptions, the inclusion of answers to multiple-choice questions and short essays. This capacity was added to the Molecular Workbench software during this project.
1. A group of three nucleotides codes for one amino acid. Notice the black tick marks above the DNA strand showing these triplet groups. How many amino acids are coded for by the strand in the model above?

(a) 3
(b) 10
(c) 20
(d) 30

My answer is (b)

2. In this model, the bottom DNA strand is transcribed. Which DNA strand is most similar to the RNA strand?

(a) The top DNA strand
(b) The bottom DNA strand

My answer is (a)

3. One amino acid in the protein is different from the others. Is it hydrophobic or hydrophilic?

(a) Hydrophobic
(b) Hydrophilic

My answer is (b)
1. Some substitution mutations result in a malfunctioning protein, but others do not. Why is this?

This might occur, because if a wrong substitution mutation happens, this could create a stop codon, causing the whole protein to mess up. Also if a mutation is in the non-coding
part of the DNA it won't effect anything, but if it's in the coding part it could effect it.


Snapshot caption: This is before I made the substitution mutation. The second L amino acid sequence is CTA.
My report on "How Mutations Work"

Snapshot caption: This is after my substitution mutation, in which I changed the second amino acid L, nucleotide sequence to TTA, instead of CTA, which in turn created a silent mutation that didn't effect the amino acid sequence at all.

1. Optional Question: How did you create a silent mutation? Explain, giving the code for the triplet where you made your substitution, before and after the mutation.

In the second L amino acid I changed the C in the nucleotide sequence to a T making the nucleotide TTA, instead of CTA. So, before the mutation the sequence was CTA, which made the amino acid L, after the substitution mutation the nucleotide sequence was TTA, creating a silent mutation, which didn't effect the amino acid at all, in turn the amino acid stayed L.

Page 4: http://mw.concord.org/modeler1.3/part1/barbara/DNAmut/mut5.cml

Snapshot caption: This is where the amino acid sequence ended, because I put in a stop codon of TAA, which turned into UAA.

1. Why do mutations that create a stop codon have a bigger effect on the protein than other mutations?

Because, they can mess up the whole amino acid sequence, because it stops instead of causing a mutation that might not effect the amino acid sequence at all. The amino acid mutation could be a silent one, but a stop codon stops the amino acid right where it is.
Snapshot caption: This is the unmutated protein sequence.

Snapshot caption: This is my amino acid sequence after the insertion mutation.
1. Why do insertion mutations have a bigger effect on the protein than substitution mutations?

Because this changes the whole amino acid sequence instead of just one amino acid.

2. How did you make an insertion or deletion mutation that did not cause a frame-shift?

I inserted 3 A's in a row at the beginning of my amino acid sequence.

1. How can a mutation be neutral?

They can be neutral, because if a substitution mutation happens, and it causes a silent mutation, then this means the amino acid would be the same and the mutation didn't effect anything.

2. Which types of mutation, among those you created in this activity, are more likely to be lethal? Why?

Stop codons, because they completely stop the amino acid sequence thus for in turn, the
rest of the sequence is not coded, this could cause a huge change in the form of the DNA.